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 Paint Shop Pro 8.0 

 
��  �����   
��  Paint Shop Pro ���  ��������  Jasc (����  ����  ���  Corel) �� ��  � �  �� ��!"��  ��#$�����  %�&��'(�  
���)��$�����  ��'# ��   ��  ��  �����  �����*��   �  +��!�������*��  %�&��$��&�'��  &,��$��&���  (bitmap) 
���-  '��   �  +����"�$(��"��  +�'��  ���  ��'# ��  . .���  ���#����  ���$�-�����  ��"  '"'��&���*  �� ��   : 
Photoshop (��,�  ��  ���  +��+�+��� �  ��#  #�� ) , Corel PhotoPaint , Ulead PhotoImpact , The GIMP. To 
Paint Shop Pro )�!,��/��  ,�  ����  ��  ��$-��  �"'����  �'�-0����  ��"  ���-  '��  ���  +" ��#����  ��"   �  
������   �  +��!����/����  '��  +�� "�����'-  $��&�'- . 
 
����	
����  
��  Paint Shop Pro 8.0 

 
 
1��'�� �"��  ��  �)(�  2���'-  ����!���  ����  ���  ���-0"��  ��"  Paint Shop Pro 

1. �����(  �� �*  .  
2. ��- ����  ��$�����0('�  $��  - ��$��  ,+����"�$��  , ���0('�"��  ,� ��$��&(  '�� . 
3. ��$�����0('�  �+���(�, -�����$�  ��"  ���!� ���  ��$�����"  �!�+����� -���)��$�����  ��  ��  �����  

��$�/#�����  �'�� �  ��  ���$�(  . ���  ��'# �  ��"  ����+��$�����  ���!�  ��$�����  ���)��$�����  
�� ��  � o  ��$�����  %���+�������   (Crop tool)    

4. ��$�����0('�  �!�+�����   .   3�  �)�������  ���  � ��"��'-  ����'-�,  
5. ���-0"��  ��  ��  ��'# �  ��"  0���"��   �  ���)��$����*��  
6. ������  !�,�-�,  . ��  '� � �'#  (�������#  '��' ) �����$�"��  ��  !����  ����'� ��"  (foreground) 

'��  ��  +�)�  '��'  ��  !����  &# ��"  (  �����'� ��"  (background) 
7. 1��! ��  ����  �� ��  ��  ���!�  !����  ����'� ��"  (  ����$�-������  . ��  ���#  '��'  ��&� �/����  � �  

���-0"��  +���#$�"  #��"  �����*��   �  +����)�"��  ��  !����  (  ��  +��2-0���� - ��$�� ��  
(gradient) (  ��  ��#�"��  (pattern) ��"  0���"�� . 

8. 4����  ��  ��  7.  ���-  $��  ��  !����   �����'� ��"  (&# ��" ). ��  6. 7. '��  8. �������*  ��  ������  
«materials» 

9. �������'#����  ���  ��'# �� . 5�(����  #��  �  ��'# �  �� ��  ��$-��  (  �!�"��  '- ��  zoom 
10. ��������  (  �����+�  ( Layers ) .��  �����+�  �� ��  �"������'-  ��'# ��  �  ���  �- ,  ���  -���  
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����������  ����  ����� -����  �������  
�����$�"��  ��#  ��  �� �*  File > New (  '���"0���  ��#  ��  2���'(  ��$�����0('�           . 
  � ��$���  �"�(  
���  ��&� �/��  ��  ����'-�,  �������  +���#$�"  ���  �����  0�  �����"��  ���  �+�#�����  ��"  0���"��   �  �!�� . �  
 ��  ��'# �   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

������������  ���������  ���������  ���  ��� ��������  

  ��$�����0('�  �!�+�����  �����������  ��#  � �  ��(0��  ��$����,  ��  ��  �����  �����*��   �  �!�+�-��"��  
(� .!  ��0�$� �� , �����  '�� )  (   �  ���)��$����*��  ��  ��'# � ( �  ��  %���+���"��  ,  �  �����)�"��  ��(����  
���  '�� ).  4��  � �  ��$�����  �!��  � �  ��*��  2��-'�  ������� �  ����  ��  '-�,  ���  +�)�-  ���"�-  ��"  �#��  
����� ��  #��   "�-�!�"  '��  -���  ���#����  ��$�����  ���+������� �  ���  0���  �'�� �  . 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

�� -+�  ��������  $��  ��  ��-���  '��  
��  *%��  ���  ��'# ��  . 1" ����  
�����$��  Pixels , Inches , Centimeters 

���/��   �-  �  � -�"��  ���  ��'# ��  0�  
"����$�����  ��  pixels � -  � ���  (  
��  pixels � -  �'�����#  

���/��  �-  ��  �����'( ��  0�  �� ��  
%�&��$��&�'�  (  +�� "�����'#  

���/��  ��  2-0��  !�������  ���  
��'# �� . 1" ����  �����    
2 !������ .      => 1 bit ,   
16 !������      => 4 bit 
�# ��  �'��/�"   => 8 bit 
256 !������    => 8 bit 
16 �'�����*���  !������  =>24bit 

1��! ��  ��  !����  &# ��" . ��  � �  
'��'  ����  ���  ��0�$� ��  �!�"��  ��  
+" ��#����   �  �����"��  � �  -���  
!����  (  +��2-0����  (  ��#�"��   

���/��  ��  ��-���  ���  ��'# ��  

���/��  ��  *%��  ���  ��'# ��  

���/��  ��  � -�"��  ���  ��'# ��

1) 6��$!��  3�����  ���  ��'# ��   => ����'� ���  
����  ���  ��'# �  #��  +�  &�� ����  #��  – ����'#  
Zoom 

2) ��������&(  ��'# ��  , �"0"$�-�����  ��'# ��  , 1�#�0,��  
�����/��"  �#$,  �, ���  0�����  , �����#�&,��  

3) ��$�����  	���+�������  ���  ��'# ��  4) ��$�����  ����'� ����  ����  �����$�� ��  �����!(�  (  � #�  
Layer ��  ���  -���  0���  ����  ���  ���-0"��  ���  ��'# ��  

5) �����$(  ����  �����!(�  ���  ��'# ��  (��0�$� �� - 
'"'��'( -'��  �����$( , ���*0���  �����$(  , �����$(  
�����!(�  ���#����"  !�������   

6) 
 ��'��-�����  � #�  !�������  ��  � �  -���   ,  �����$(  
!�������  ����  ��#  ��  ��'# �  $��  ��  &# ��  (  ��  ����'( ��  

7) �� ��� -2�*����  ,�����  ,7�*����  �����#�&,���  8)  � �*����   ��, ��������   , 
���-'�" ��  $�����" ��  

9) ��$�����  �)��-�" ���  , 4)" ���  
 ��0����  , 
�&�  �� ����  ,
*)����  (  ���,��  �,��� #�����  

10) ��$�����  �,��� #�����  ,�������* , 
�#!�,���  

11) ��$�����  �2������   '��  �2��������  �# �  ��"  
&# ��"  

12) ��$�����  “Picture Tube”  $��  /,$�-&����  ��  ��'# ��  

13) ��$�����  ����������  �����!(� -��"2-�  

15) �!�+����  ��0�$, �,  ,�*'�, , ���"$� ,  '��  

14) ��$�����  ����$,$(�  ����� �"  ����  ���  ��'# �  

16) �!�+����  �"0���  '��  '���"��  '8 ���)��$����  
1�� "�����'�  

17) ��$�����  �����$(� , ��������&(�  '��   1�� "�����'�  
�!��-�, -
 ��'���� ,  
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�-0�  � �  ��#  ��  �����- ,  ��$�����  �!��  � �  �* ���  �+���(�, -�����$�  ��"  ���������*   '��  � ��#$,�  
��  !�(��  ��" . ��  �����$�� -�+�#�����  ��"  ���!� ��� -� ��$�*  ��$�����"  &�� � ���  ���  ��������	  

��	�
��
���  ��������� -
������� . 6���  #��  �����$��  �  2�*����              �#��  �  ��$�����0('�  �����$�  
�!��  ��  ����'-�,  ���&(  
         

 
 
 
 
 

 
 
 
 
 
 
 

 

Crop Tool 

Move Tool 

Picture Tube 

Text Tool 

Flood Fill Tool 

Preset Shape Tool 

Object Selection Tool 

Pen Tool 
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�������!�  
��  ���  	����"�  ���������  
��  �������������  ���������  
����'-�,  +� ����  ���  ���  ��������(�  ����$��&(  �,  ���  2���'�  ��$����,  . 
  ���0����  ��"  
�'���"0�����  (&�� ����  +�)�-  ��#  ��  ��$����� ) � ������!��  ���  0���  ��"  2���'����  ��  ��$�����  ���  
��$�����0('�  (#�,�  ���0�(0�'�  ���  ����$�*�� �  ���-$��&�  - ��#  �- ,  ����  ��  '-�, ). 
 
 
                               �  2 
��  ��$�����  �"�#  ���  +� ��  ��  +" ��#����   �  �
����������
 (rotate) �  �	  	�������
 (resize) ��  
���

��  (��-���  , *%�� ) � #�  �����+�" -layer ('��  '��-  ���'����  #���  ���  ��'# ��  (  � #�  �����$�� �"  
��(�����  ��� ) . �#���  ��  �����)�"��  ��&� �/����  ���  ���/# ���  $����(  ��#  ��  '� ���  ����  +�)�-   '��  � �  
����$�����  ��  '�"'�+�� (��2�� ) ����  $, ���  '��  ���  ����  �,  ���"��  .��- � ���  ��  +�)�  -'��  ���  
$����(�   �����*��   �  ��  ��������%�"��   ����   �  ��������&��  '��  ��'# �  .��- � ���  '��  ��� � ���  ���  
'�"'�+��  �")����� �"��  '��  ��  +�-�����  ���  ��'# �� . ��0� #   �  ��&� ����*  $'��/�  '  ��"'-  
�����$, -'��  �"�-  � ������,��*�"  ��  +��&� ��  
 

     
 
 
 
 
                          �  2   
��   ��$�����   �"�#  ���  +� ��  ��  +" ��#����  �	  
�
���	�������
  ��	  
����	  ��������&� ���  ��  ����  
 �  ��  &�� ����  #��  �� ��  ����2( . 
"�#  2�2���  ������   �  $� ��  '��  ��  ��  ����$�*�� �  ��$�����  
��������&� ���  � -��$�  (  ��#  ��  �� �*  Image=>Rotate ���-  ���  +*�'���  '��  ��  ��'���*�  
������������*�  . ���-  ��  �����$(  ��"  ��$�����"  ��&� �/����  ���  ����  ���  ��'# ��  ���  ���/# ���  
$����(  ���  ������  ��  -'��  �����*   �  ����'� �0�* . ���    �  �"0"$�������"��  ��  ��'# �  ������0�*��   
 �  2��*��  ����  ��  �"�(  ���  �"0���  ��  '����  �  �����  '� � �'-  0�  ������   �  (��  ���/# ��� . ���#��  
����'� �*��  ��  $����(  ��"  ��$�����"  ��� � ���  ��  -'��  ���  ����   �  ��"������  (  �������������  ��  ��  
'�'���� �  �"0���  ���  ��'# �� . ���  ����'-�,  ���-+��$��  ��������*��  #��  �  �������(  ��'# �  &�� ����  
��$�  ����2(  ����  '��  ��  ����-'�  $�� ��  �������-  '��  ��  +���-'�  +��! ��   �  '���&���/��  ����  �������- . 
����'� � ���  ��  -����  $����(   ����   �  ��"������  ��  ��  ��)#  +���-'�  (2�  ��'# � ) '��  '- � ���  +���#  
'��'  ��  ��  �� ��'�  ((  �����$� ���           apply  ��#  ��  ��$�����0('�  �����$� ) �  ��'# �  (3�  ) ���-/�� . 

 

 
 


���$(  ��-��"�  '  *%�"�  

��������&(  ���  ��'# ��  



Pan (www.klain.gr  -  www.edutorials.gr ).  –  ����������  Jasc Paint Shop Pro 8.0  

 5

 
                          
                           �  2 
��  ��$�����  �"�#  ���  +� ��  ��  +" ��#����  �	  �	�	���������
  ����  
���  �����	���  ���  
����	  . ��  
��(0��  '-0��,  '��  ���/# ��,  $�����  ��"  ���$�����  ���/����  ���  ��$�����0('�  �����$� . ��  ������  
���(�  '�0��,  '��  ���/# ��,  �����*   �  ����'� �0�*  ��  «�*��  '��  -�� » ���'��� ���  ���  � -��$�  
�����#�&,��  ���  ��'# �  ,  
 
 

        
 
 
        Crop Tool   �  3          
���	�
��   	������	���  – !����	���  . ��  ��  ��$�����  �"�#  ����'#���"��  ��(����  ��'# ��  ��"  +�  
0���"��  ���/� ���  ���  ��0�$� �� . �����!(  ���  ��'# ��  ��  �����   ��"  0���"��   �  '���(��"��  
                    

              
 
 
 

    Move Tool �  4 
To ��$�����  �"�#  ���  +� ��  ��  +" ��#����   �  �
�	��������
  ���  
����	  �  ��	  
������  ���  �  ��	  

���
��  (Layer) ���  ��  ���  -���  0��� . 7���'-   ��  ��$�����  !��������������  �# �  $��  Layers ���-  ��  
Paint Shop Pro � �����,��/��  ��#'����  ��  ��'# �  '�0��  '��  '-0�  �����$(  ��(�����  ���  ��  Layer.  
 
 

             
 
 
    
 

����'� ���  #���  ���  ��'# ��  ����'� ���  � #�   �����$�� �"  ��(�����  
���  ��'# ��  . ��  !����  ��"  � ��'�0���-  ��  
�����$�� �  �����!(  �� ��   ��  !����  &� ��* . 

����'� ���  Layers. 
  ��'# �  �����������  
��#  2 �����+� -Layers ��  �����   
����'� (0�'�  �������-  '��  +�)�-  $��   �  
&�� � ���  '��  ��  +"�  ( '��-/  )  
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                            ��� �  5    

 
���	�
��  
�������   ����  (  ������#���,  �����!�  ���  ��'# ��  �
  "���  ������  ����	
��������  �#��	  
�����$(�  #�,�  ��0�$� ��  , '*'���  ,�����%� , ���$, �  ,�� �-$, �  ,������  '�� . (��  �!(��  ��"  0�  �!��  �  
�����$(  �����*��   �  ��  �����"��  ���  ��$�����0('�  �����$� ) . ��������*��  #��  #��  �����$��   ���  
�����!(  �#��  ���'�-  � �  '� �*�� �  ����$�����  ��#  +��'�'���� ��  $������  . $  ���	��	  ���  

���
������  ����	���  ��	�  
����	�  �#
�  �	  ���
�  �
  ��  �
�����  ���  ��
�  ��  
����
�
�  ����  
	�����	���  , #���	�����%  ,�#
��	���  , �
�	�#��	������  
�
  , ���  	����%�  �	�  
�	�������	�  ����  
����  
������  �&( � ���  � ���������  ��  "�#�����  ��  �����$�� �  �����!(  ���  ��'# ��   . �-  ���  
"�-�!�"��  �����$(  ��"  '���(�,  ��  ��('���  Ctrl ������ �  �#��  ��#  ��  "�-�!�"��  �����$(  �&��������  
�   �� . �-  #�,�  '����  ������ �  ��  Shift '��  �!������,  ���   ��  �����$(  �#��  �"�(  ������0����  ���  (+�  
"�-�!�"��  (�������(  �����$( ). 
 

                 
 
 
 
 
 

  ��0�$� ��  �����$(  ���  �������  ��'# �  �!��  �����$��  +� � ���  ���  �+�#����  feather ( ���  
��$�����0('�  �����$�   $��  ��  ��$�����  «Selection» ) ���  ���(  ��$��*����  ��"  0 ( ���  ���-+��$��  20). 

"�#  �!��  ��  ����������  ��  ����$�����  ���  �����$(�  ���   �  ��  �� ��  ��#����  ���-   �  "�-�!��  ���  
����(  +��2-0����  ��#  ��  $���� �'-  pixel. 6���  �  $� ��  � ��$��&(  (Edit > Copy) ���  �����$(�  '��  
���'#�����  ���  ��   ��  ��'# �  (Edit>Paste>Paste As New Image) ��  ����������  0�  �� ��  #�,�  
����'-�, . 

     
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

��0�$� ��  �����$(  �����$(  ��  �!(��  
�������*  ��#   ��  �����  
�!��  �&����0��  ���  �2-�  
�����!(  (������ �  Ctrl) 

�������(  �����$(   
���$, �  + '*'���  
(������ �  Shift) 

��0�$� ��  �����$(  ��  
����(  +��2-0����   ���  
����$�����  �����$(�  
(feather) 
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                                        �  5   
���	�
��  ��
%

���  ��������  – &��� . ��  �"�#  �����$�"��  �����+(����  ��(����  ���  ��'# ��  
���0"��*��  !,���   �  �������/#�����  ���  ������  �!(����  �����$(�  . 
  ��$�����0('�  �����$�  ���  
+� ��   4 +��&�����'�*�  �*��"�   �����$(�  ���  ��#��  !�(���  ��"  9-��  : 	 ) Edge Seeker  . ��  �"�(  ��  
�����$(  '- �"��  2�0�����  '��'  ��  '�����  ������  ��"  ����$�-������  � #�  � ��'���� �"  ���  ��'# ��  
'��  ��  Paint Shop Pro �"�#����  '�����2�� ��  ��  � +�-����  ������ .  " )Freehand   . ��  ��  ��#��  �"�#  
�����*��  ���*0���  ��� � ���  ��  �� ��'�   �  �����)�"��   ���  �����+(����  �����!(   � )Point to Point  
.
  �����$(  +����"�$�����  ��  +��+�!�'-  '��'  (������ ) ����  ���  ��'# �  ��  �����  � � � ���  ����)*  ��"  
��  �"0����  � )Smart Edge .�  ��#���  �"�#�  ���"!�� ��  #��  '��  ��  (� ) Edge Seeker  ���-  ��  ��$��*����  
�'��2��� . ���-  ��  +��+�'����  �����$(�  ��&� �/����  ���  �,��+�  ��  �����   0�  ������  ����)*  �,  
+��+�!�'�  '��'   �  �������2- ��  ��  ����$�����  ��"  � ��'���� �"  ( �  '��*����  +���+(  pixels  ��"  
� ��'���� �"  '��  ��"  &# ��" ).  
����'-  $��   �  o��'���,0��  �  �����$(  ('��  $��  ��"�  4 ��#��"� ) '- �"��  +�)�  '��'  '��  '�� ��  �  
+��'�'���� �  –'� �*�� �  $����(  �����$(�  ��  ��  �����  ������  ��#  ��  �����  ��!���  )�'� (��� . ���  
����'-�,  ���-+��$��  $� ����  �����-0���   �  �����!���  ��  '�&-��  ��"  ��"'�*  �'"��*  '- � ���  !�(��  
��"  9-��  (� ) ��  ��  ��#��  Freehand '��  (2) ��  ��  ��#��  Smart Edge  
 

                  
 
           
 
 
 
 

                                            �  5         
'�  (	����  �	"��  �	�  ���
�  ���  ���	�����	  �	  
��������
  �
���#��  �����  �  �	�������  #���	��� . 
  
!�(��  ��"  ��$�'�*  ��2+��"  �� ��  ���(  : '- � ���  '��'  ��  � �  ������  ���  ��'# ��  �#��  �����$� ���  #��  ��  
$���� �'-  pixels ��  ��  �+��  (  ���#����  !����  . ��  �#��  ���#����  ( ��  ��  pixel ��"  '��' )  !������  0�  
�����$�"  �)���-���  ��#  ��  �+�#����  «Tolerance» (� �!( ) �  �����  #��  �!��  ��'�(  ���(  �#��  �  �����$(  
�� ��  ���  �'��2(�  '��  -��  '��  ���  ��'�(   �  �����$(  � �  #��  �!��  ���  ��$-��  ���(  �#��  �����$� ���  pixels 
��  !����  ��"  +��&����  ������#����  ��#  ��  ������  ��"  '��' , -��  0�  �!,  ��$��*����  �����$( . 
  !�(��  
��"  ��$�'�*  ��2+��*  �� ��  '��-�����  $��  �����$(  � ��'���� ,  ��  �������'�  �!(��  ��  �����   2���'� ���  
��  &# ��  � #�  �"$'�'���� �"  !������� . 

 
 
 
 
 
 
 
 
 
 
 

9-��  ��  ��#��  �����$(�  Freehand. ��  ����������  
#�,�  &�� ����  +�  �� ��  '��  �#��  �'��2��  ���-  �� ��  �  
�# ��  ��#���  #��   ��  � ��'���� �  �!��  ���*���'�  
�!(��  �  +�  +��!,��/����  ��&��  ��#  ��  &# ��   

9-��  ��  ��#��   �����$(�  Smart  Edge. ��  
����������  #�,�  &�� ����  �� ��  ���*  ���  
�'��2��  ����  '��  �  �����$(  �&���#/��  
�'��2��  ���  ����$�����  ��"  '�&���� *   

�����$(  ��(�����  ��"  
�"�� �*  ��  ��  ��$�'#  
��2+�  
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                                            �  6              
 
��  ��$�����  �"�#  +�"��*��  ��  �
���	��������  (��	�����
��� ). �- � ���  �������#  '��'  ��  � �  pixel 
���  ��'# ��  '�0���-  ��  !����  �'�� �"  ��"  pixel !����  ����'� ��"  � �  ��  +�)�  ��  '�0���-  !����  
�����'� ��"  

 
 
 
 
 
 
 
 
 
 
 
 

 
 
                                           �  6   
��  ��$�����  �"�#  !��������������  $��   �  	����	�	����
�  ��	  ����
�������  #���	  ((  ���#����  ��"  
� -��$�  ��  ��  ���(  «Tolerance») �
  ��	  ����  !,���   �  �����-���  -���  !������ . ��  +"�  �"�-  !������  
���  �����  0�  $� ��  � ����$(  ������   �  ������*  ��  !����  ����'( ��"  ��  � �  '��  ��  !����  
�����'� ��"  ��  -��� . 4��  ��  ��$�����  !��������������  ��  ��  �������#  ��('���  ��"  �� ��'��*  �#��  ��  
��'� �����!���  ��"  �!�"  ��  !����  ��"  &# ��" ((  ���#���� ) ���-/�"  !����  ���  !����  ��"  ����'( ��"  
(!����  �����'� ��"  �  !����  ����'� ��" ), � �  ��  ��  +�)�  ��('���  ��"  �� ��'�*  $� ����  �  � ��0���  
� ��'��-�����  (!����  ����'� ��"  �  !����  �����'� ��" ). 
  !�(��  ��"  ��$�����"  ������   �  $� ��  ��  
+"�  ��#��"�  : � )����'-  . ���  pixels ��"  0���"��   ��  �&���#/�"��  ��  ��$�����  ��  �� ���   2)��0���'- . 
��  +���#  '��'  (�������#  (  +�)�  � ��#$,�  ���  !����  0��,   �  � ��'������0�� ) #��  ��  pixels ���  ��'# ��  
��"  �!�"  !����  ��  �"�#  ��  �����  0��,   �  � ��'�����(�,  ���-/�"  !���� . 
 
 
 

 
 
 
 
 
 
 
 
                                                                  
 
 
 
 

 
 
 
 
 
 

����'( ��  

�����'( �� . ��  
���#  '��'  �- ,  
��&� �/����  ���  
������  !�,�-�,  . 
���  ���-+��$��  
�����)���  '���� �   

���#��  �����$�"��  ��  ��$�����  Color 
Replace (� ��'��-�����  !�������  ) '��  
0���"��  ���  �����$(  Tolerance 
+�'������'-  ���  ���(  $*�,  ���  30 ����  
 �  �"������-2��  '��  ���  +�-&����  
���!������  ��"  ����  ���  0-������ .  


�!�'-  !����������*��   ��  
���$� #�����  ��  �������#  '��'  
�- ,  ��  � �  pixel ���  ��'# ��   
'��  ��  '�0����*��  !����  
����'( ��" . ���  ���-+��$� �  
�����)���  ��  ����  !����  ���  
0-������  

��  +�)�  +���#  '��'  ��  ����  !����  
���  ��'# ��  (0-����� ) 0�  
� ��'������0��  ��#  ��  '���� �   


������#  '��'  1�)�   '��'  

+���#  
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                                           (��%���	  )���	����� )  �  7 

  2�*����  �� ��  ��  ��$�����  ��  ��  �����  �����*��   �  /,$��&���"��  ���*0���  . ��� � ���  ��  �� ��'�  ��  
��  �������#  ��('���  �  2�*����  /,$��&�/��  ��  ��  !����  – +��2-0����  - ��#�"��  ��"  �!�"��  �����)��  $��  
��  ����'( ��  � �  ��  ��  +�)�  �"�#  ��"  �!�"��  �����)��  $��  ��  �����'( �� (&# �� ). 
 
 
                               (*���� ) ��� �  7 
��  ��$�����  �"�#  �&( ��  ����*�,��  #�,�  � �  �����  .  

    
 
 
 
 
 
 
 
 
 
 
 

 
 
                                      (��%���	  +	�	�������� ) ��� �  7 

  2�*����  �����#�&,��  ���  +� ��  ��  +" ��#����   �  �������&���"��  ��(����  ���  ��'# ��  
+����"�$� ���  ������  &����  �������  '���'���*���  . 
 -��$�  ��  ��  �����$(  ��"  �!�"��  '- ��  ���  
��$�����0('�  �����$�  �����*��   �  +��$'���"��   , ��������%�"��  , �����'* �"��  '��  +�-&���  ������  
���  ��'# �� . 
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                               (,����������  -�	�������� )   �  8 
��  ��$�����  �"�#  ��"  ���������  �*'���  '��  $�($���   �  +���0��,  &,��$��&���  ��"  �!�"  $�����" ��� . 
�����$� ���  ��  �  +��'���  ��"  �� ��'��*  ���� ��  ��  �'#��"0�  �!(��           . ���   �  +���0��,  ��  
$�����" �-  '- ,  '��'  ��  � �  ��!�'#  ������  ���  '��  ��� ,  ��  �� ��'�  �- ,  ���  . ��0��  ��� ,  ��  �� ��'�  
��������  #��  ��&� �/����  ���  �"0*$�����  �,��+�  �  �����  0�  ������   �  ����'�����  ��  $�����" �-  . 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

                             (��%���	  !����������� ) �  8 

  2�*����  '�, ��������  ��"  +� ��  ��  +" ��#����   �  � ��$�-&,  ('�, ����, ) ���  �����!(  ���  ��'# ��  
��  ���  -���  0���   . ��#'�����  $��  � �  +" ��#  ��$�����  ��  ��  �����  �����   �  '�*2,  ��������  (  
� ��'���� �  ��"  +�  0�  (0���   �  "�-�!�"  ���  ��'# �  ��" . 
  ���&(  ��"  ���� ��  �  +��'���  ��"  
�� ��'��*  $��  �"�#  ��  ��$�����  �� ��              . ���   �  ��  !���������(�,  ��!�'-  0�  ������   �  '- ,  +�)�  
'��'  ���  ������  ������"��  ���  ��'# ��  ��#  ��  �����  0�  � ��$�-&��  �  2�*����  '�, �������� . ���#��  
��$�� ,  ���  �����!(  ��������#  ���  ��'# ��  '��  ��  '� � �'#  '��'  /,$��&�/,  . ��������  #��  '�0��  
��� ,  ��  2�*����  ��  Paint Shop Pro ��"  +��! ��  ��  ��  �*�2���         ��#  ����  0���  � ��$�-&��  .  
     
 


  ��!�'(  ��'# �  �����!��  
���  $�����" �-  

��� �"��  ��  �� ��'�  �- ,  ���  
$�����" �- . 
   �,��+�  
����'�����  ��  $�����" �-  


  ������" �-  �����'�* 0�'�  
��#  ��  ��'# �  ���   


�!�'-  '- ,   +�)�  '��'  �- ,  ���  
!#���  ����   �  ����,  ��#  ����  
�����  ���   ��'# ��  0�  � ��$�-&��  �  
2�*����  

���#��  ��  �������#  '��'  ��� ,  ��  
2�*����  �- ,  ���  ��*��  ��'�*�� . 
���  0���  ���  ��'�*���  � ��$�-&����  
��  !#���  ��#  ��  0���  ��"   

��  ����'#  ����������  &�� ����  
����*�,�  &"�����$�'#  ��   �  ��  
"�(�!�  ����  �  ��*��  ��'�*��  ���-  
�# �  !#���  
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                                    (*"����	 ) �  11 

  �2�����  ��"  +� ��  ��  +" ��#����   �  �2(�,  �����!��  ��'# ��  ��  ��  !����  ��"  �!,  �����)��  $��  &# �� . 

  #�,�  �2( ,  ��  ������ �  ��  +�)�  ��('���  �#��  �2( ��  ���  !����  ��"  ����'� ��"    
 

 
 

 
 
 
 

 
 
 
                                     (*"�����  .����� ) �  11 
��  ��$�����  �"�#  ��"  +� ��  ��  +" ��#����   �  �2(�,  ��  &# ��  ��#  ���  ��'# �  �&( � ���  � ���������  
��  +�-&���  � ��'���� �  ��� . ��#'�����  $��  � �  ���*  '��#  ��#��  ��  ��  �����  �����   �  ����� ��,  
� ��'���� �  ��#  ��  &# ��  ��'��  2�2���   �  "�-�!��   ��&(�  +��!,����#�  ���  !����  �,  � ��'���� ,  ��#  
��  !����  ��"  &# ��"  . ���   �  ��  '���&��,  �"�#  0�  ������    �  �&���#/,  ��  '� ���  ��"  ��$�����"   �- ,  
��  ��'� �����!���  ��"  &# ��"  . ���#��  ��"  ��  ��$�0��  ��"  �!,  �����)��  $��  ��  ��$�����  ������   �  �� ��  
��$-��  ('-��  ��  �����  0��,  ����  ��  ��$��  '� (����   �  �2(�,  ��  &# ��  ) '��  ������   �  '��*����  '��  ��  
+�-&���  � ��'���� �  ���  ��'# ��  �"�-  +�  ��#'�����   �  �2����*  ���-  �# �  #��  pixel �!�"  ���#����  
!����   ��  ��  &# �� . ��  �2(����  ��"  &# ��"  ���  ��'# ��  ��  '- ��  +�-&� �  (-����  '��  $'��/�  ����-$, � ) 
 
 

 
 
 
 
 
 

���  �����- ,  ��'# �  0�  
������0(��"��   �  
+��$�-%�"��  ��  ����  ��"  
�"�� �*  ��  �����  ��������  ��  
&# ��  ���  ��'# ��  

��� �"��  ��  ��$�����  �- ,  
���  &# �� . ��������*��  #��  
���#��  ��"  ��  ��0�$� ��  
��� ��  ��"�  �*�$�"�  �"���  +�  
+��$�-&� ���  

����'-  �!��  +��$�-&��  ��  
&# ��  (�$� �  +�-&� � ) '��  
�!�"  ����� ,0��  �# �  ��  
'�����  
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           Picture Tube Tool �  12 
��  ��$�����  �"�#  �!��  ��  �+�#����   �   �&( ��   ����*�,��   ��#  +�-&����  �������  ��'# ��  � ��   �  
/,$��&�/��  ��  '-����  !����  . ������   �  &� ��  ���*  !�(����  #��  0��(��"��   �  +�� 0���"��  ���  ��'# �   
+� � ���  ���  ���  ���  �"!-�����  '��  �*0"��  ���0��� . ��  '���$#���  ��'# ,  $��  ��  ����*�,��  ��"  
��$�����"  �����*��   �  ��  +����)�"��  ��#  ��  ��$�����0('�  �����$�  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
           Food Fill Tool (���"�� ) �  13 
��  ��$�����  ��"  '�"2�  ��  !����������*��  $��  �	  �
������
  �
���#��  (��  ��	����	���
� ) ���  ��'# ��  ��  
� �  !�,��  (  ���  +��2�0����  (  � �  ��#�"�� . 4��   ��  �����$�"��  �  +��'���  ��"  �� ��'�"  ���� ��  ��  
���&�            '��  ��  �������#  '��'  $���/�"��  ���  �����!�  ��  ��  !�,��  ����'� ��"  � �  ��  +�)�  ��  ��  
!�,��  &� ��"  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


�#  ��  �����  �"�(  �����$�"��  ��  
��'# �  ��"  0���"��   �  ����"�� ��  ��  
��$�����  


  �����- ,  ��'# �  �� ��  � �  ���-+��$��  ��"  
��$�����"  picture tube 


������#  '��'  $���/��  ��  ��  !����  ����'( ��"  

1�)�  '��'  $���/��  ��  ��  !����  &# ��"  

�# ��  

����'( ��  
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          Text Tool (���	�
��  �
������ ) �  14 
��  ��  ��$�����  '���� �"  �����   �  ���-$,  � �  '���� �  ���  ��'# �  ��" . ��  ��  �����$(  ��"  ��$�����"  �  
+��'���  ���� ��  ��  �'#��"0�  �!(��           . �- � ���  '��'  ���  ������  ��"  0��,   �  ���-$,  ��  '���� �  
��&� �/����  � �   ���-0"��   +�-��$�"       ����  ���  �����  �����   �  $�-%,  ��  '���� �  ��"  0��, . ���  
������,��  ��"  ��$�����"  '���� �"  ��  !����  &# ��"  � ������!��  ���  $������  �,  $����-�,  � �  ��  
!����  ����'� ��"  ���  !����  ��"  0�  �!��  ��  ����$�����  ��"�       
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
              Preset Shape Tool (���	�
��  *#������ ) �  15 
��  ��$�����  �!��-�,  ��"  +� ��  ��  +" ��#����   �  !���������(�,  ������  �!(����  ����  ���  ��'# �  ��" . 
���  �+�  ��  !����  ����'� ��"  � ������!��  ���  !����  ���  $����(�  - ����$�-������  ��"  �!(�����  � �  ��  
!����  &# ��"  ���  $������  ��"  �!(����� . ��  !������  �"�-  '��#  �� ��   �  ��  ���/,  ���  '- ,  ��  
�!(���� . �-  0��,  '��#��   �  ���)��$����  ��  �!(��  '��#  �� ��   �  ��  ����,  ,�  +�� "�����'# (�����$(  
«Create as vector») 

������������-  , ��$�0��   ��$�0��   - ��!��  
����$�-������  

����!���  ��"�  ���&(�  (� �� � , ��-$��  '�� ) 

����$�����  

�������  �&#��  ��  '���� �  ���-$����  ��  +�� "�����'#  
$��&�'#  (�����$(  «Create as : Vector» ���  
��$�����0('�  �����$� ) +����"�$�����  �"�#��� �  
� �  �����+� -Layer ��  # ���  ��  '���� �  ��"  
���-$��� . ��  +���#  '��'  �����  � -  �-��  ���$�(  
 �  +���0��,  ��  '���� �  ��"  

�����$(  �!(�����  1�� "�����'#  �!(��  ��"�  $����(� (�" �!(�  ,+��'�'���� �  '�� ) �-!��  �����(�  

���  '-0�  �!(��  ��  �����  �� ��  +�� "�����'#  
��  Paint Shop Pro +����"�$��  '��  ��#  � �  
+�� "�����'#  �����+�  (Layer) 
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           Pen Tool (*#
��	��  -�	���� , ��
�
��	��	  *��
���  *#������ ) �  16 
��  ��$�����  ���  �� ��   ��"  +� ��  ��  +" ��#����   �  +����"�$(��"��  $������  (+�� "�����'��  '��  �� ) ��  
������  ������   �  �� ��  �"0����  (  '���*���  ,'�0��  ������  '��   �  ���)��$����  ���  $������  '��  ��  ������  
��#  ��  +�� "�����'-  �!(����  ��"  �!,  ���  ��'# � . ���#  �� ��  ���  $������  ��"  0�  &��-),   �  ���  ����,  
��  +�� "�����'-  �!(����  («Create As Vector» ���  ��$�����0('�  �����$� ) ����  �-  0��,   �  �����  
 �  ���  ���)��$����  '��  ���-  ��  +����"�$��  ��"� . ���  �+�  ��  !����  ����'� ��"  � ������!��   ���  !����  
$����(�  � �  ��  !����  &# ��"   ���  $������  ���  �����!(�  ��"  ���/����  ��#  ���  $������  ��" . 
 
 
 
 
 

 
 
 
 
 
��  ����'-�,  3 ����+��$����  �!�"  $� ��  ��  ���  �����$��  «Create as Vector» '��  «Contiguous»  �  �� ��  
� ��$������� ��  ��  '��-�����  +����"�$���  $�����  (         ) 

 
 
 
 
 
                                                                                                                                   
 
 
 
 

                                                                                    
 
 
 
 
���  ����'-�,  ����+��$����  &�� ����  �  +" ��#����  ��"  ��$�����"   �  ���)��$-/����  ��  +�� "�����'-  
�!(����  
+	���
���	  1 

                                                                         
 
 
 
 
 
 


  '���*��  �"�(  �$� �  ��  +��+�!�'-  '��'  . 
���-  ��#  '-0�  '��'  ��  PSP +� ��  ��  
+" ��#����  ���  ��(��   ��"  �#���  &��-)���   
 �  ��  '���"����"��  . ���  ���-+��$��  
�!�"��  2-���  '��  !����  $���������    


  '���*��  �"�(  �!��  $� ��   �� � � ���  ��  
�� ��'�  ���*0���  .��  PSP 0�  � ����  #��  
��  ������  ��  $������  

��  $������  ��"  
�!�+�-/,   �  �� ��  
�" �!#�� ��  (  #!�  


  $������   �  �� ��  
+�� "�����'��  (  #!�  

���-�����  ���)��$�����  ��"  
�!(�����  : �����$(  �����,  , 
����'� ���  �����,  '��  

���-�����  
1����"�$���  
������    

���-�����  
��%������  
�����!(�  ��"  
�!(�����    

�"0*$�����  
��(����  ��  
+��+�!�'-  '��'  

����*���  
��  +��+�!�'-  
'��'  

���*0���  �!�+��  
��� � ���  ��  �� ��'�  

��"�  $����(�  : 
�" �!(�  , 
+��'���� �  '��  

�-!��  $����(�   


  $����(  �����������  ��#  �" �!#�� �  
�"0*$�����  ��(����  ��  �����  �$� �  
��  +��+�!�'-  '��'  ���  ������  ��"  
&�� � ���  

�-  '- �"��  +�)�  '��'  ��  � �   ��#  ��  ������  ���  $����(�  
��&� �/����  � �  �� �*  4 �����$�  : (1)1����"�$��   ���  
$����(�  (2) 
 ��$��&( , 
��'��( , 1��$��&( , ��������  
�����(�  '��  (3)�*���  ������" -�����(�  , ����"��������  
(4) ��������&(  , ����'#�"&��  & ���/# ����  ����������#�  
'��  

6!�"��  ��  +" ��#����   �  ��-��"��  
� �  ������  '��   �  ��  �*��"��  ��  -���  
0���   

1 
2 
3 
4 
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+	���
���	  2 
 

 
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
 
 
 
                                                                                                  
                                                                                 
 
 

 
 
  
 
 
 
           Object Selection Tool (���	�
��  ��������  /�	����	�����  *#������ ) �  17 
��  ��  ��$�����  �"�#  �����   �  �����$,  +�� "�����'-  � ��'���� �  ($������  '��  ���*$, �  ) '- � ���  
'��'  �- ,  ��"�  . ���#��  �����   �  ����'� (�,  ,  �   ��������%,  ,  �  ���-),  ���  +����-����  ��"�  
�����'* � ���  (  �"���' � � ���  ��  ,  �  ���-),  ��  !����  $����(�  (  $���������  '�0��  '��   �  
���)��$����  ��  ������  ��"�  ���-  ��  ��  ��$�����  ���  �� ��  . 

 
 
 
 
 
 
 
 
 

 
 

�!�+�-/�"��  ��  �!(��  
� �  +�� "�����'#  ������  

�����$�"��  #��  ��  ������  
��"  �������*  ��  ��  �� �   

1�)�  '��'  �- ,  ���  �����$(  '��  �����$�"��  
«Node Type» => «Symmetric». 6���  
'���"�� � ���  ��  $, ���  

�����$�"��  ��  ������  ���  
'� ���  ��"  �������*   

��- �"��  � �  ������  ��"  
�������*  '��  ��  ��� �"��   

��  ������  ���-/��  ��  �������  
���  0-������  


  ��'# �  �"�(  �����������  
��#  � �  ��(0��  
+�� "�����'�  �!��-�,  

�- �"��  '��'  ���  �"  �&-'�  . 
"�#  
�����$����  ��  � �  �������  $*�,  ��"  ��  
�����  �����!��  ������  ��  �����  �����*��  
 �  �*��"��  $��   �  ���-)�"��  ��  ��$�0��  
��"  '��  ���  ���/# ���  $����(  ���  � ���  ��  
�����  �����*��   �  ��������%�"��  

��  �"  �&-'�  ��  ����'� �*��  , 
��  ��'��� �"��  '��  ��  
��������&�"��  
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����
�  «Materials» (����
�  #���

�� ,  #�"��  ����������  – $��
��  , 
�������  ��"��
�� - ���	
������ - ���
%���  ) 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
4�,�   � �&��0�'�  ��  � �  '��'  �- ,  ���  ��0�$� ��  ��"  ���!� ���  !�������  ����'( ��"  (  &# ��"  
�!�"��  ��  +" ��#����   �  �����"��  ��  !����  (  ��  +��2-0����  (  ��  ��#�"��  ��"  0���"��  . 
"�#  $� ����  
��  ��  ��&- ���  ��"  ����'-�,   ����0*��"  «Material» ��  �����  �!��  3 '�������  Color , Gradient , Pattern 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

+	���	  #������� . ��  �������#  '��'  �- ,  ��  � �  
!����  ��  ���/�"��  ��  !����  ����'( ��"  � �  ��  
+�)�  ��  !����  &# ��"  

���  +��! ��  ����  �� ��  ��  ���#��  #���	  ���������� . 

  '- �"��  '��'  �- ,  ��"  0�  ���  � ��)��  ��  
���-0"��  �����$(�  !������� - +��2-0����� - 
����*��"   

���  +��! ��  ����  �� ��  ��  ���#��  #���	  ������ . 
  
'- �"��  '��'  �- ,  ��"  0�  ���  � ��)��  ��  ���-0"��  
�����$(�  !�������  – +��2-0�����  - ����*��"  

5����  (Color)

1��2-0����  – (gradient) 

��#�"��  (pattern) 

4��  �� ��  ������ �   ����� ��  5,���  
!����  (+�-&� � ) 

���/�"  �-  ��  ����'( ��  (  ��  &# ��  0�  
�!��  !����   (  +��2-0����  (  ��#�"��  
� -��$�  ��  ��  �� ��  �����$�� �  ��#  ��  3 

4��  �� ��  ������ �  ���/��  #��  0�  
�&��������  ���  ���  	��  ������  
�����  ���  ���!�  !����  ����'( ��"  (  
&# ��" . 9�$� ���  "&(  �  ��*��  ��  
���0���  ��"  � -$�"&�"  � #�  "��'�*  
�!  "&(   )*��" , ���!�" , "&-������ , 
������'�* , !�����*  , ������   '��  

1��! ��  ��  ����$�*�� �  !����  

!	����	  Color 

�����$� ���  � �  !����   ��#  ��  
��$-��  '*'��  ��  � �  ���#  '��'  
(��'�#  '"'��'� )  �  ��#!�,��  ��"  
�����$� �"  ����  ���-/��  �!� ���  
����2���#�� �  &,��� #����  '��  
� ����  $��  ��  �"$'�'���� �  !����  .  

���!�  !����  ��  �����  ��  
�����$�"��  �'�� �  ��  ���$�(  

��  '��'  ����  ���  ����-$, �  
�����$,  ��  !����  ��"  0��,  (��'�#  
'"'��'� ) 

������  !�,�-�,  ��  ���'�0������ �  
!������  ��#  ��  �����  �����   �  
�����),  � �   

�����$(  5�������  ��  2-��  ��  �� ����  
RGB ���/� ���  ���  � ������!��  �����  ���  
Red('#''� � ) Green(��-�� � ) '��  
Blue(���� ) ��#  0 �,�  255 

4����  ��  ��  �����- ,  ���-  $��  ��  
�� ����  HSL (
�#!�,��  ,������#�  , 
�,��� #����  ) 

� ��$������  ���  "&(  $��  ��  
�"$'�'���� �  !����  �� ��  ��   �  
�!�"��  ������ �  ��   

�����$(  
����  
:&(�  
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/��������	  ��	�  ��	�  �����  �	�  ��	"�
�����  : 
&�*  ���(��"��  ��  '�"���   «Edit» ��&� �/����  ��  
����'-�,  ���-0"��  

 
   
 
 
 
 
 
 
 
 
 
 
 
 
 

���#��  0�  ���)��$����*��  ��   ��  +��2-0����  ���  !������  ��"  0���"��  
 

 
 
 
 
 
 
 
 
 
 
 
 
 

!	����	  Gradient -/�	"�
����  

�����$(  ����  "�-�!�"���  +��2-0�����  

��"�  1��2-0�����  

���)��$����  �����$�� ��   
1��2-0�����  (  1����"�$��  
����  

���� ���  «New..» ��&� �/����  � �  ���-0"��  #��"  
�����*��   �  +���"��  � �  # ���  ���   ��  ���  +��2-0����  

�#���  +����"�$(����  ��  
 ��  +��2-0����  


   ��  +��2-0����  �����������  ��!�'-  
��#  2 «���'�+#��"� » ��  ��  �+��  !����  

���   �  ���-)�"��  ��  !����  � #�  ���'�+#��"  '- �"��  '��'  
�- ,  ��" . ��  !����  ��"  �!��  �'�� �  ��  ���$�(  &�� ����  
�'��  ��"  +��! ��  ��  2���� . ��  '��'  ���  �������  !�������  
��&� �/����  �  ������  !�,�-�,  #��"  +����$�"��  !����  

���  �����!(  �"�(  '- �"��  '��'  $��  
 �  ���-$�"��   ��"�  ���'�+#��"�  ��  
!������  ��"  0�  +��2�0��/� ���   

���  �����- ,  ���-+��$��  
2-����  3  ��"�  ���'�+#��"�  
����)*  �,  2 ��!�'�   
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!	����	  Pattern 

�����$(  � #�  "�-�!� ���  ����*��"  

�, ��  ��  ��  �����  0�  
�&��������  ��  ��#�"��  

�����'�  ��$�0�"�  ��  ��  
�����  0�  �&��������  ��  
��#�"��  
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'�012!�*  �+�3�4-,*2,*  & /25467*$*  �2!51,*  
1) /���
���  !�������  (	����  �
  .�����	��
�  
 

         
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
 
 
 

 
 
 
 
 
 
 

���  �����- ,  &,��$��&��   ��  �-���  
�,  ���+��  �� ��  '#''� �  '-��  ���*  
�" �0���� �  ����  &,��$��&���  

�����$,  ��#  ��  �� �*  «Adjust» ��  
�����$(  «Red-eye Removal».  

� ����'��'-  �����$,  ��#  ��  
��$�����0('�  «Photo» �&#��  �� ��  
����(  ��  �����$(  «Red-eye 
Removal».  

�  

���  �������  �"�#  '- �"��  
'��'  �- ,  ���  '#''� �  
�-���  . ��  '-0�  '��'  
��&� �/����   � �  '"'��'�  
��  �����  ������   �  
�����-),  �- ,  ���  
'#''� �  '#��  ��"  �����* . 
��  '"'��'��  �"�-  
�����*   �  ����'� �0�*  
(  '��   �  ���-)�"  ��$�0��  

���  �������  &�� ����  ��  
����������  ���-  ��#  '-0�  
'"'��'�  ��"  2-/�"��  
������-  ���  �-���  �,  
���+��  

�����$(  ����  
�#!�,���  
$��  ��  �-���  

��$�0��  ���+��  �����*  �����$(  � #�  !�������  
��#  ��  ��#!�,��  $��  ��  
�-���  

���  ����'#  
���������  ��  
'#''� �  �-���  �!�"  +���0,0��  

1��$��&(  � #�  '*'��"  ��  �-��  
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2) /���
���  .��
������	�  �	�  ,���

���  (Contrast) �
  .�����	��
�   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

H �����- ,  &,��$��&��  
&�� ����  �'���� (  '��  !,���  
��$-��  � ��0���  !�,�-�,  

�����$,  ��#  � o �� �*  Adjust =>Brightness and Contrast=> Brightness and Contrast 

���  �������  �"�#  
")- �"��  
��  &,��� #����  ���  ���(  ��"  
0���"�� . ���  ���-+��$��  
2-����  ���(  35. �" (0,�  
���/�"��  ��  ���  �����  ��!��   �  
+�*��  � �  �'� �������'#  
����������  

���  �������  �"�#  
")- �"��  
��  ���(  ���  � ��0����  


���������  


  ����'(  ��'# �  �� ��  ���  
&,��� (  '��  �"+�-'����  '��  ��  
��$��*����  � ��0���  
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2) /���
���  !�������  0���	���  �
  .�����	��
�   
  
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

���  �����- ,  &,��$��&��   ��  
!����  ��"  +�������  ���  '������  
&�� ����  '#'' � �  '��  ����'��� �  � �  
'��  �  &,��$��&��  �� ��  �'���� (  

�����$,  ��#  � o �� �*  Adjust =>Hue and Saturation=> Hue/Saturation/Lightness… 


�#  ��  � �+����*�� �  �����   Edit  
�����$�"��  Reds ('#''� � ) +�#�� 
0���"��   �  +���0���"��  ��  
"���2���'#  '#''� �  ���  ��'# ��  


�� ��$�����*��  ��  �����$(  
Colorize 

��-��  �*0�����  ���  &,��� #����� . 
4��  ��  ����'� �*��  ���-/��  �  ���(  
��  &,��� #����� . ���  ���-+��$��  
�")(����  ��  &,��� #����  ��  20 

��-��  �*0�����  ���  � ����� -
'������*  ��"  !�������  . ���  
���-+��$��  ��������  ��  ���(  
��    -30 $��   �  ���,0��  �  � ����  
��"  '#''� �"  

��-��  �*0�����  ���  
��#!�,���  . ���  ���-+��$��  
�&( �"��  ��  ���(  0 ����  '��  
�"�(  +�  0�  ���-)��  ��  
��#!�,��  �,  '#''� ,  ��  
-���  !����  ��#!�,���  

���  ����'#  ����������  ��  !����  ��"  +�������   
�!��  +���0,0��   '��  �  ��'# �  �!��  $� ��  ���  &,��� (  
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4) !
��
��  �
  /�	�����  
+	���
���	  1 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
+	���
���	  2 
 
 
 
 
 
 
 
                                                           
 
                                                                              

6��,  #��  0���"��   �  $�-%�"��   '���� �  
�- ,  ��  +��+���(  � #�  '*'��" . ��  ��  
��$�����  �!��-�,  �!�+�-/,  � �  
+�� "�����'#  '*'��  (Create as vector � ��$# ) 

�����$,  ��  ��$�����  '���� �"         '��  ��$�� ,  �,  +��'��  ��"  �� ��'�*  
�- ,  ���  ������"  ��"  '*'��"  ��#  #��"  0��,   �  ��!����  ��  '���� �  
��" . �#���  �����-�,  ��  �� ��'�  ���  '���*��  '��  �  +��'���  ���-)��  
�!(��  ��            '- ,  '��'  '��  ���'�����$�  ��  '���� �  ��"  

��  '���� �  $�-&��'�  �- ,  ���  '*'��  

���   �  ���'�*%,  ��  '*'��  ��$��  ,  
���  Layers ���  �����+�  ��"  '*'��"  
(Vector 1=>Ellipse ) '��  '- ,  '��'  
���  �-��  ��#'�"%��  �����+�"  
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�+2+�/,  – LAYERS (*����
�� ) 
'�  
��	�  : 
��   �����+�  �� ��  2���'-  ��'# ��  �  ���  �- ,  ���  -���  . 
"�#  ��������   ���  ��!"�(  +" ��#����  ��  ��  
�����  �����*��   �  ����0���"��   ��   ����!���  ���  ��'# �  ���  (�!  '���� �  , �&�  , -����  ��'# ��  ,�-�'��  
��#'�"%��  '�� ) ��  �����  ������0� ���  ��  )�!,����-  �����+�  '��  ��  �����  �����*   �  ���)��$����*   ��  
'-0�  � �  )�!,����-  �&( � ���  � ���������  ��  ��!�'(  ��'# �  (�  �����  ��������  '��  �"�(  � �  �����+� ) 
� �  �  �* 0���  ��"�  ������   �  ���  +����  � �"�,���'-  ������������ . 3�  ������   �  $ ,��/�"��  #�,�  #��  
�   !�(��  �����+,  �������  ������#����  � (��  ����  '��  �!�"��  ������  )�!,������  ��'# ��  '��  #��  ���  
�����  �-  0���"��   �  ������"��  ��  ���0�'�"��'#  !���   �"$!, �*�"��   #��  ��  �����+�  ��  � �   . ��  
'�� ��  �*���  ���0('�"���  ��'# ,  (bmp , jpg , gif  '�� ) +�  ���0�'�*�"  ��  )�!,����-  �����+�   '��  
�" (0,�  ��  � �  ��#  �"�-  ���0�'�*�"��  ��  ����'(  ���  ��'# � . �-  0���"��  #�,�   �  ���0�'�*��"��  
#��  ��  �����+�  ����  ����� ��'-   �  ��  ���)��$����*��   �#��  0�  ������   �  ���0�'�*��"��  ��  ��'# �  ���  
���  &�����  ��"  Paint Shop Pro ( .psp ,  .pspimage) (  ���  &�����  ��"  PhotoShop ( .psd) 
 

 
 
 
���-+��$��  ��'# ��  ��  �����+�  
 

       


  ��'# �  ���  �����������  ��#  +�-&���  �����+�  ���  ������  �,  Layers &�� � ���  ��  +�-&���  
�����+�  ��#  ��  �����   �����������  �  ��'# �  ���   
'�0��  ������  '��  ��  +�-&����  �"0������  $��  ��  
'-0�  Layer  
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+	���	  Layers   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
��  +�)�  '��'  �- ,  ��  � �  �����+�  ��&� �/����  ��  ����'-�,  �� �*  ���"  �����"��   �  �����)�"��  '������  
� ��$����  $��  ��  Layers - �����+�  
    
 
    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

���   Mask Layer 
        Vector Layer    
        Raster Layer 

1��$��&(  
�����$�� �"  
Layer 

1����"�$��  � #�  Group 
���+��������  Layers 

1����"�$��  � ��$�-&�"   
��"  �����$�� �"  Layer 

� #����  �,  
+�-&��,  �����+,  . 
�-0�  �����+�  ��"  
�� ��  ��  � �����  0���  
��#  -���  0�,������  
#��  2���'����  ����  
������-  ��  �!���  ��  
��  -��� . �����*��  
 �  ��"�  ���-)�"��  
0���  ��� � ���   ��  
�����+�  ��  ���  -���  
0���   

��#���  ��#����)��  
�,  pixels � #�  Layer 
��  �"�#  ��"  �� ��  ��#  
'-�,  ��"  

������#  �+��&- ����  ��"  
Layer. �-  �� ��  100 �#��  
�  �+��&- ���  �� ��  ��(��  
� �  �  �� ��  0 �#��  ��  
�����+�  �� ��  �����,�  
+�-&� �  '��  +�  &�� ����  
������  ��#  �"�#  

���/��  �-  ��  �����+�  0�  �� ��  ����#   
                      >>              (  ��  ����#  

���  Raster �����+�  
���  Vector (+�� "�����'# ) �����+�  
���  ���+�������  Group �����+,  
���  �����+�  �-�'��  
���  �����+�  ��������$(�   
-------------------------------------------------------------------------------------- 

1���������#�  �����+�"   
 ��$�-&�"  
1��$��&(  �����+�"  

�����+�������  ���+������� ,  �����+,  
���� ������  �����+�"  
�+�#�����  �����+�"  

----------------------------------------------------------- ------------------------- 
3���  �����+�"  (���  �- , -'-�, , ���  '��"&( -����� ) 
�����$(  ���,  �����+,  �� ��  ����-  
�"$!� �"��  �����+,  ��  � �   
------------- -------------------- ---------------- ----- 
��������(  �����+�"  ��  Raster  
��������(  ��"  Background �����+�"  ��  Raster 
��������(  �����$(�  ��  Raster �����+�  
Defloat  
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(
��%  Layers   
��  �����"�$���  �� ��  � -��$��  ��  �"���  ��"  � �+"#�� �"  �� �*  ���-  ��#  +�)�  '��'  �- ,  ���  Layers 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
'%���  ��������  
��  PSP !�����������  ��"�  �'#��"0�"�  �*��"�  �����+,  

1. Raster        . ���  �*��  �"�#  2-/�"��  %�&��$��&�'�  ����!���  ��"  �������* ���  ��#  pixels 
+��&�����'�  !�,�-�,  ����0����� �  ��  � �  ���$��  

2. Adjustment – +���	������ . �� ��   �����+�  ��  �����  �&���#/�"  '-����  �*0����  !�������  , 
&,��� #�����  , � ��0����  '��  ���  "��'���� �  �����+�  !,���  �"�#   �  �����-/���� . ��  ����$��  �� ��  
�+���  ���  "��'���� �  �����+�  �-  �&���#/� ��  ��  �"�#  ���#�����  �"0������  ��#  ��  �� �*  Adjust. 
��  �����+�  ��������$(�  +�  �����*   �  2���'� ���  ���  �����  

3. Vector – /�	����	���� .          �� ��  ��  �����+�  ��  �����  �����!�"  +�� "�����'-  � ��'���� �   
#�,�  $������  , �!(����  '��  '���� �  ��  +�� "�����'(  ���&(  

4. Mask – (���
�  .       ��  �-�'��  �� ��  �����+�  ��  �����  '�*2�"  ��(����  � #�  "��'���� �"   
�����+�"  . ���  �"���  �� ��  �����+�  �*0�����  ���  +��&- ����  (-��  '��  ���  �+��&- ���� ) �,  
"��'���� ,  �����+,  '��  $��  �"�#  ��  �#$�  !����������* ���  �- ��  ��  �" +"���#  ��  ��  �����+�  
��"  2���'����  ��#  '-�,  ��"�  '��  ����   �# �  ��"�  . ��  � �  �����+�   �-�'��  /,$��&�/�"��  ��  
!������  '����'��  $'��/�"  ��  �����  +�  ��  2����"��  ���-  2����"��  �,�  ���-/��  �  �+��&- ���  
��"  "��'���� �"  �����+�" . ��  ��*��  '�*2��  �����,�  ��  "��'���� �  �����+�  '��  -��  ��  '- ��  
��(�,�  +��&� ��  � �  ��  -����  ��  ��&� �/��  (��(��  �+��&- ���  ��"  "��'���� �"  �����+�" ) +��  
&�� � ���  #��  ��  pixels ��"  "��'���� �"  �����+�"  

5. Background .  �� ��  ��  �����+�  ��"  2���'����  ���  '-�,  . ��  # ���  ��"  +�  ������   �  ���-)��  
�'�#�  �-  ����������  ��  Raster (�����$(  «Promote Background Layer» ��#  ��  �� �*  Layers). 
4���  ��  ��'# ��  �*��"  BMP , JPG , GIF #��  ���  � ��$�"��  �!�"  �# �  � �  �����+�  ��  �����+�  
Background. �"��'-  '��  #��  +����"�$�*��  ���   ��  ��'# �  �#��  �"�(  �!��  ������  ��  �� �+�'#  
�����+�  ��  Background 

 

���  Raster �����+�  
���  Vector (+�� "�����'# ) �����+�  
���  ���+�������  Group �����+,  
���  �����+�  �-�'��  
���  �����+�  �"0����,   
------------------------------------------------------------ 
1���������#�  �����+�"   
 ��$�-&�"  
1��$��&(  �����+�"  

�����+�������  ���+������� ,  �����+,  
�+�#�����  �����+�"  
------------------------------ ------------------------- 
3���  �����+�"  (���  �- , -'-�, , ���  '��"&( -
��!( ) 
�����$(  ���,  �����+,   �  �� ��  ����-  
�"$!� �"��  �����+,  ��  � �   
------------- -------------------- ---------------- ----- 
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'�����  �����
����  
���  ��������  �
  ��  ����
��
��  ���  
��  PSP !�����������  ��"�  �'#��"0�"�  ��#��"�  ��#����)��  � #�  �����+�"  ��  ��  �����+�  ��"  2���'� ���  
���  '-�,  : 
�������  ��	
��  ��
��
���  

Normal 


"�(  �� ��  �  '� � �'(  ��0�+��  ���)�� . �+�  +�  $� ����  '����  ����$(  ���  !������  ��"  �����$�� �"  
���������  ,��&� �/��  ��  pixels �,  '������,  �����+,  � -��$�  ��  ��  �+��&- ���  ��"  �!�"��  
������  ���  �����$�� �  �����+�  . 4��  ���  ��'�(  �  �+��&- ���  �#��  ������#����  pixels '������,  
�����+,  &�� � ���  

Darken ��&� �/��  ��  pixels ��"  �����$�� �"  �����+�"  �&#��  �"�-  �� ��  ���  �'���� -  ��#  �"�-  ��  '������,  
�����+,  � �  ��  ���  &,��� -  +�  &�� � ���  

Lighten ��&� �/��  ��  pixels ��"  �����$�� �"  �����+�"  �&#��  �"�-  �� ��  ���  &,��� -  ��#  �,  '������,  
�����+,  � �  ��  ���  &,��� -  +�  &�� � ���  

Hue �&���#/��  ��  ��#!�,��  ��"  �����$�� �"  �����+�"  ���  '�������  !,���  ����$(  ��"  '������*  '��  ���  
&,��� #�����  

Hue (Legacy) �&���#/��  ��  ��#!�,��  ��"  �����$�� �"  �����+�"  ���  '�������  !,���  ����$(  ��"  '������*  '��  ���  
&,��� #�����  

Saturation �&���#/��  ��  '�����#  ��"  �����$�� �"  �����+�"  ���  '�������  !,���  ����$(  ���  ��#!�,���  '��  ���  
&,��� #�����  

Luminance �&���#/��  ��  �,��� #����  (Luminance (  Lightness) ��"  �����$�� �"  �����+�"  ���  "��'���� �  !,���  
#�,�   �  �����-/��  ��  ��#!�,��  (Hue) (  ��  '�����#  (Saturation) ��"�  

Luminance 
(Legacy) 

�&���#/��  ��  �,��� #����  (Luminance (  Lightness) ��"  �����$�� �"  �����+�"  ���  "��'���� �  !,���  
#�,�   �  �����-/��  ��  ��#!�,��  (Hue) (  ��  '�����#  (Saturation) ��"�  

Multiply �" +"-/��  ��  !������  ��"  �����$�� �"  �����+�"  ��  �"�-  �,  "��'���� ,   ����   �  ����!0�*  ���  
�'���� -  !������   

Screen. 
��  ����������  �!��  ��  �+��  (  ���  &,��� -  pixel $��  ��  �����$�� �  �����+� . 
"�#  ���"!�� ����  
�&���#/� ���  ��#��  ���)��  multiply ���  !�,����'-  � -����&�  ��"  �����$�� �"  '��  �,  '������,  
�����+,  

Dissolve 

 ��'�0���-  �"!���  ��  pixels ��"  �����$�� �"  �����+�"  ��  �"�-  ��"  "��'���� �"  . 
  �+��&- ���  ��"  
�����$�� �"  �����+�"  '�0���/��  ��  ��(0��  �,  pixels ��"  � ��'�0���-  – #��  ��$��*����  �+��&- ���  
�#��  ��$#����  pixels � ��'�0���� ���  ��#  ��  "��'���� �  �����+�  

Overlay. �'�"��� �"  ������#����  ��  �'���� ��  �����!��  '��  &,��/� ���  ������#����  ��  &,��� ��  ��"  
"���'���� �"  ��������� . 

Hard Light. 
")- ����  �  � ��0���  �,  !�,�-�,  ��"  "���'���� �"  ��������� . ��  &,��� ��  �����!��  &,��/� ���  
��$�  �����- , , ���-  ��  �'���� ��  �'�"��� �"  ������#���� . 

Soft Light ��  !������  ��"  "���'���� �"  ���������  &,��/� ���  ��$�  �����- , , &,��/� ���  ���  &,��� ��  
�����!��  '��  �'�"��� � ���  ���  �'���� ��  �����!�� . 

Dodge. �,��/� ���  �# �  ��  � ��!�-  !������ , � �  ���  �'�*��  ���-/��  �  ��#!�,�� . 

Color. �&���#/��  ��  ��#!�,��  '��  ��  � ����  ('�����# ) ��"  �����$�� �"  �����+�"  ���  '�������  !,���   �  
�����-/��  ��  &,��� #���� . 

Color (Legacy). �&���#/��  ��  ��#!�,��  '��  ��  � ����  ('�����# ) ��"  �����$�� �"  �����+�"  ���  '�������  !,���   �  
�����-/��  ��  &,��� #����  

Difference. 1����"�$�����  � �  �&�  �� ���'�*  !�������  ���  �����$�� �  ������ . 

Exclusion. ��  � ��!�-  !������  ��"  "���'���� �"  ���������  � ������&� ��� , � �  ��  �'�*��  ���'��*  ���  ���  
$'��/�  ��#!�,�� . 

Saturation. 
��-/��  �  � ����  �,  !�,�-�,  ��"  "���'���� �"  ��������� . ��  !������  +�  &�� � ���  '��-  �#$,  
�,  !�,�-�,  ��"  �����'� ��" . 

 
                                                  

4��  ��  �����+�  �!�"  ��#��  ���)��  «Normal» '��  $��  �"�#  
&�� ����  ��#'����  �# �  ��  �����+�  ��"  ����-$, �"  ��"  
�� ��  ���  �- ,  ��#  ��  -���  

���  �����+�  ��"  ����-$, �"   �������  �*��  ��#����)��  
«Darken» � �  ���  �����+�  ��"  '*'��"  �������  �*��  ���)��  
«Multiply» 

(1) (2) 
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+,4,/�2-(,  1 (!����  ������� ) 
���  ���-+��$��  �"�#  !����������*��  3 +��&�����'��  ��'# ��  ���  ������  0�  ���  � ���"��  ('��-/ ) ��  ���  

               
 
 
 
 
 
 
 
 
 

 
 
 

 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
             
 
 
 
 
 
 
 
 

 
 
 
 

����&���"��   ��  �����+�  �,  +"�  �������-  
��'# ,  ���  ��'# �  ��"  �����"  '��  ����  
+����"�$�����  ���  ��'# �  ��  3 �����+� . 
� ����'��'-  �����*��   �  � ��$�-%�"��   ��  
'-0�  ��'# �  ( Edit => Copy ) '��   �  ��  
���'���(��"��  ��   ��  �����+�  ���  ��'# �  ��"  
�����"  (Edit=>Paste =>Paste As New Layer) 

5����������*��  ��  ��$�����  ����'� ����           $��  
 �  ����'� (��"��   ��  �����+�  ��"  �����"  �������-   
'��  ��  �����+�  ��"  �� ����"  +�)�-  

����  &�� � ���  '��  ��  3 �����+� . ���   �  �!,  � �  ���  #���&�  ����������  !����������  ��  �2(����  ��  '"'��'#  �!(��  , 
�'���#����  10 '��  �+��&- ���  70. ���#��  �����$,  ��  �����+�  ��  ��  ��"��*+��  '��  �2( ,  ���  -'���  ��"  ��"  �" ���*�"  ��  
��  �����+�  ��"  �����" . ���-  �����$,  ��  �����+�  ��  ��  �� ����  '��  �2( ,  ����  -'���  ��"  ��  ��  ��"��*+�� . ��  ����������  
&�� ����  +�)�-  

9�:9�:1�
  

(51'�&5  
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+,4,/�2-(,  2 (0����  (���	�  ��	  ,�������  +
���#��  
���  
������� ) 

 
 
 
 
 
 
 
 

 
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
+,4,/�2-(,  3 (0����  (	����  ��	  �����  2 
������  �
  ��	"�
����  ���  ��	  ����  ����  Fade In-
Fade Out) 

 
 
 
 
 
 
 

        
         
                                                                           

 
                                                                                                                                                     

1����"�$�*��  � �  �����+�  �-�'��  '- � ���  '��'  
���  � ������!�  '�"���  ���  ������  Layer 

1����"�$(0�'�  � �  �����+�  
�-�'��  �- ,  ��#  ��  �����+�  
��"  �� ����"  


  ������  !�,�-�,  ���-/��   
'��  ����  +��! ��  �# �  �# �"�  
$'��/�" . ��  �� *��  !����  ���  
�-�'�   ��  ���'�*2��   #��  
� �  ��  -����  ��  ��&� �/��  
#�� .. ��  � +�-�����  �����  ��  
$'��/�  !������  ���'���*  
� +�-�����  ���'�*%���  

�����$,  !����  ����'� ��"  ��  ��*��  (��(��  ��#'�"%�  ) '��  
��  ��  2�*����   /,$��&�/,  ���  ���!�  ���,  ��#  ��  �� ���� . 
  
2�*����  ���  �����+�  ���  �-�'��  +�  �&( ��  ��*��  ����* -
�,��  ���-  ���'����  ��#'�"%�  ���  �����!(  ��"  2�"���� -
/�"��  !,���   �  �����-/����  �  ��!�'(  ��'# �  ��"  �� ����"  

�  ���!��  +�  &�� ����  ����  '��  �  �-�'�  ��"  
+����"�$(����  ��  ���'�*2��  . 
&( � ���  ��  
�� ��'�  �- ,  ���  � ������!�  �����+�   2����"��  ��  
��'��$��&��  ��  ���&(  ��"  �!�"  ��  �����+�  ���  
#�,�  &�� ����  �- ,  +�)�-   


  ���&(  
���  �-�'��  
���  

��  �����+�  
��  ��  
��!�'(  
��'# �  ���   

5����������*��  ���  +"�  ��'# ��  '��  ��  �*��  '��  -��   ����&��,  ��  
�����+�  ��"  �� ����"  ����  ���  �������  ���  ��'# ��  


  ��'# �  ��"  �����!��  ��  2 �����+�   ��  
��  �����+�  ��"  �� ����"   �  &�� ����   
�# �  $����  2���'����  ���  �- ,   
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+,4,/�2-(,  4 ((
�	�����  ��������  �
  ����
��  , /���	��	����  �������� ) 
 
�
�
�
�
�
��������������������������������������������������� ���������������������������
�
�
�
�
�
�
�
�
�
�
�
�
�
�
�
�
�
�
�
�
�

�����$�"��  �����  ��  �����+�  ��"  �� ����"  '��  ���-  ���-$�"��  1 
�����+�  �-�'��  ��  �����  ����0�������  �- ,  ��#  ��  �����+�  ��"  
�� ����"   

�������  

Mask - �������  

�����$�"��  ��  �����+�  «Mask �����9� ». 
���#��  �����$�"��  ��  !����  ����'( ��"  ���  
+��2-0����  ��#  ��*��  ���  -����  '��  ��  ��  
'�"2-  '- �"��  '��'  $��   �  $�����"��  ��  �-�'�   

H ���+����  ���  +��2�0����� ��  �-�'��  ��!�  ��  
����������  ��  �����+�  ��"  �� ����"   �  $� ����  
���+��'-  ����#  ��#  �������-  ����  ��  +�)�-  '��  
 �  &� ��  ����  '��  ��  �����+�  �,  ��"��"+��  

���  ���,��  ��"  ���0�'�"��'�*  #$'�"  ���  ��'# ��  
�"$!, �*�"��  #��  ��  �����+�  «Layers=> Merge=> 
Merge All (Flatten)» 


�!�'-  �!�"��  ��  �����- ,  ��'# �  ��"  
�����������  �# �  ��#  ��  �����+�  
«Background». �����$�"��  ��  ��  �-��  ��  
��$'�"; �  �������-  

�����$�"��  ��#  ��  �� �*
«Selections =>Promote Selection 
To Layer» . 
"�#  ����������  ��  
�����$(  ���  ��  Raster �����+� . 
������  �����$�"��   �-��  
«Selections=>Select None» $��  
 �  &*$�� ��  ����$�����  ���  
�����$(�  

����'� �*��  ��  �����+�  Promoted 
Selection �������-   ��  ��  ��$�����  
����'� ����                
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�������  , /��������	  
���%�����  !������  )   
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1������-/�"��   - +����"�$�*��  � ��$��&�  - ��"  �����+�"   
«Promoted Selection» ��"  ��$'�"; �"  '��  +����"�$�����  ����  �- ,  
��  �����+�   «Copy Promoted Selection». ��  �����+�  �"�#  � ������!��  
��  � �   ��  ��$'�"; �  ��"  2���'����  ���  �+��  0���  ��  ��  -���  

  (  � ����'��'-   « Layers => Duplicate » 

��  ��  ��$�����  DeForm         ����'� �   ��   ��  
�����+�  +�)�-  , ��'��� ,  ��  ��$�0��  ��"  '��  ��  
��������&,  ���&�-  �������- . ��  ����������  
&�� ����  ���  �����- ,  ��'# �  

1����"�$(0�'�  � ��$��&�  
��"  �����+�"  CAR 

����'� �  ��  �����+�  «Copy of CAR» 
�������-  '��  0��,  ���(  �+��&- ����  30 

1������-/�"��   ��  �����+�  
Copy of CAR 

1����"�$(0�'�  � ��$��&�  
��"  �����+�"  Copy of CAR 
��  Copy(2) of CAR 
 

����'� �  ��  �����+�  «Copy(2) of CAR» 
�������-  '��  0��,  ���(  �+��&- ����  15 
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���%�����  !	���������%  �
  1
��  )   
 

                                    
 
 

             
 
 
 
 
 
 
 
 

x 2 


  "�-�!�"��  ��'# �  
 �  ����0���0��  �- ,  
���  '��2-  
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�����$(  �# �  ��"  ���&� ��  – ��  �- ,  ���#  . 

 )��  ��  ��$�����  ��0�$� ���  �����$(�  �   
7)��  ��  ��$�'#  ��2+�  �- ,  ���  -����  '��  
'��#��  � ������&�  ���  �����$(�  

�- �"��  ��  �����$(  ���   �����+� -Layer 
���  '��#��  ��� ��$�����*��  ��  �����$(  : 
Selections->Select None 

�����$,  ��   ��  �����+�  $��   �  �&���#�,  
���  ����'-�,  ����������  
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�&�  '"�������*  

����'(  ��'# �  ��  ��  ��+,��   � ��*  . ������   �  
!��������   �  ��  %���+���"��  ��$�  ����   �  &*$�"  ��  
��*��  '"���-'��  ����  -'���  ���  ��'# ��  


